ONYX® OCR
Portable Video Magnifier
User’s Guide

Supplement to the ONYX Deskset HD User’s Guide

Freedom Scientific, Inc.
www.FreedomScientific.com
440847-001 Revision D
Safety and Maintenance

To keep the unit in good condition and to ensure safe usage, observe the following guidelines:

- Read the instructions in this user's guide before attempting to use the unit.
- Do not attempt to repair the unit or open its case. This product contains no user serviceable parts.
- Do not attempt to modify the remote control. Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.
- Keep the unit away from wet areas, rain, and other sources of liquids or high humidity. Do not submerge the unit.
- Always operate the unit in a place where the temperature is between 10° and 40° C (50° and 104° F).
- Always store the unit in a place where the temperature is between -20° and 65° C (-4° and 149° F).
- Always use the unit on a stable, level, hard surface such as a desk or table.
- When cleaning the screen, camera lens, or close-up lens, unplug the power cord and apply a small amount of non-abrasive cleanser, such as the following, to a soft, lint-free cloth and gently wipe:
  - Water
  - Isopropyl alcohol
  - Petroleum benzene
  - Vinegar mixed with water at a concentration of no more than 10 percent vinegar, for example, 1.5 tablespoons of vinegar per cup of water (100 ml per liter)

**CAUTION:**

Do not apply excessive pressure to the screen, camera, or close-up lens. Do not spray cleanser directly on these items. Also, do not use any cleanser that contains the following agents: acetone, ethyl alcohol, ethyl acid, ammonia, or methyl chloride.

When cleaning the rest of the unit, make sure the unit is unplugged. Use a lightly dampened, soft, clean cloth with water or mild detergent.
Federal Communications Commission (FCC) Compliance Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna
- Increase the separation between the equipment and receiver
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected
- Consult the dealer or an experienced radio or television technician for help

CAUTION: Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Industry Canada (IC) Compliance Statement

CAN ICES-3(B)/NMB-3(B)
# Table of Contents

**Introduction** ................................................................................................................................................................................. 1

**Quick Start** ......................................................................................................................................................................................... 2
  - Powering On the Unit ........................................................................................................................................................................ 2
  - Tap and Go ....................................................................................................................................................................................... 3
  - Changing Text and Background Colors ........................................................................................................................................ 8

**Button Bar** ........................................................................................................................................................................................... 9
  - Menu (Gray) ....................................................................................................................................................................................... 9
  - Magnification (Yellow) ...................................................................................................................................................................... 9
  - Play / Pause Speech (White) ......................................................................................................................................................... 9
  - Speech Volume (Blue) ...................................................................................................................................................................... 10
  - Reading Speed (Green) .................................................................................................................................................................... 10
  - Close (Red) ................................................................................................................................................................................... 10

**General Operation** .............................................................................................................................................................................. 11
  - Magnifying a Document ................................................................................................................................................................. 11
  - Reading a Document ...................................................................................................................................................................... 11

**ONYX OCR Main Menu** ....................................................................................................................................................................... 12
  - Opening and Closing the Main Menu .......................................................................................................................................... 12
  - Using the Main Menu .................................................................................................................................................................... 13
  - Save ................................................................................................................................................................................................ 13
  - Open ................................................................................................................................................................................................ 17
Delete ......................................................................................................................... 19
Voice ............................................................................................................................ 20
View .............................................................................................................................. 21
Settings .......................................................................................................................... 23
Restore Defaults ........................................................................................................... 29
About ............................................................................................................................ 29

Removing OCR Camera for Travel .................................................................................. 30

Service and Support ....................................................................................................... 31
Congratulations on choosing the Freedom Scientific ONYX® OCR, an intuitive video magnifier that allows you to listen to, view, and magnify text.

A simple screen tap changes your unit from an ONYX Deskset HD video magnifier to an ONYX OCR. With the addition of the OCR camera, you can use the on-screen button bar controls to:

- Acquire and process a document displayed on the screen
- Listen to the unit read the processed text
- See a full page view of the document with clearly marked reading zones. This allows for fast document navigation by tapping a zone and having immediate speech from that part of the document.
- Continue to add more pages to the document, and quickly save it to an SD card

In addition to processing and reading text, the ONYX OCR can also be used as a picture viewer. This lets you capture a photograph, zoom in to view details, and save the picture to an SD card.

**About this Guide**

This guide will familiarize you with the speech features and functions of the ONYX OCR. Please read it carefully before using your ONYX OCR. For standard video magnifier operation, please refer to your ONYX Deskset HD user guide.

At Freedom Scientific, we are constantly improving our products and their functionality. Therefore, it is possible that this manual is not the latest version. Please download the most up-to-date manual by visiting [www.Freedom Scientific.com](http://www.Freedom Scientific.com), choosing Support, and then Documentation.
Quick Start

Note: The ONYX OCR has two operational modes: video magnifier mode and OCR mode.

When in video magnifier mode, the unit functions exactly as an ONYX Deskset HD video magnifier without OCR functionality. For standard video magnifier operation, please refer to your ONYX Deskset HD user guide.

Powering On the Unit

1. If the unit is off, press the green **Power** button located in the upper left corner of the remote control to power it on.

   **Note:** If the unit does not power on, make sure the main power switch on the back of the unit is in the ON (I) position.

   Also make sure the power cord is plugged into the unit and power outlet.

2. As the unit boots, an audible beep is heard for approximately 40 seconds, followed by silence, and then an audible chime.

   The unit is now ready for use in OCR mode.
**Tap and Go**

To get started with your ONYX OCR, do the following:

1. Tap the screen once in the bottom right corner to start OCR mode.

   The screen goes dark for a moment as the unit switches from the video magnification camera to the ONYX OCR camera.

**Note:** To switch to OCR mode, the default method is to tap the screen in the lower right corner. This can be changed so that any tap on the screen while in video magnifier mode will automatically launch OCR mode. For more information, refer to *Activate Speech (Starting OCR Mode)* on page 27.
2. When “Speech on” is announced, do the following:

- Rotate the page guide from the closed to open position (A). When closed, the guide’s handle is located on the right side of the unit’s base.

- Place the document you want to read under the side-mounted OCR camera and against the page guide (B)
3. Position the document so that it displays inside the yellow document outline box that appears on the screen.
4. Tap the screen, and the ONYX OCR captures and processes the document and starts reading within several seconds.
5. The document displays on the screen with each reading zone marked with large blue numbered bullets:

These numbers represent the most likely order of the text in the document.

You can tap any number and the ONYX OCR starts reading from the selected zone.

The white numbered bullet is the zone that is being read.

Note: Photos display in their original colors. To magnify a photo, tap it once. To return to the full page view, tap the photo again.

6. To read multiple pages in the same document, or pages in a new document, do the following:

- **Press and hold** the red Close button until the yellow document outline box appears
- Place a new page inside the yellow outline, and tap the screen

7. To pause speech, tap the white Play/Pause Speech button located in the center of the button bar.

8. To exit OCR mode, tap the red Close button on the right side of the button bar.
Changing Text and Background Colors

To enhance the contrast of the text, a text foreground and background color can be selected. If no high contrast color is needed, the text can be displayed in its original colors.

To quickly change color settings, tap followed by and then

Refer to Color on page 21 for more information about color settings.

Note: This will not influence the representation of pictures. Pictures always display in their original colors.
Use the ONYX OCR button bar to start and pause speech, adjust magnification, adjust volume, adjust reading speed, activate the Main menu, and exit OCR mode and return to video magnifier mode.

The button bar displays across the bottom of the screen when in OCR mode.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Menu](image) | **Menu (Gray)**  
Tap to enter the menu. |
| ![Magnification](image) | **Magnification (Yellow)**  
Tap the **Minus** button “–” to decrease magnification.  
Tap the **Plus** button “+” to increase magnification.  
Tap the center **Overview** button to switch between Overview and the last used magnification level. |
| ![Play/Pause](image) | **Play / Pause Speech (White)**  
Tap the center button to toggle between starting and pausing speech.  
Tap the left **Previous** button to move to the previous page in a multipage file.  
Tap the left **Next** button to move to the next page in a multipage file. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Speech Volume (Blue)" /></td>
<td><strong>Speech Volume (Blue)</strong>&lt;br&gt;Tap the left blue speaker button to decrease speech volume.&lt;br&gt;Tap the right blue speaker button to increase speech volume.</td>
</tr>
<tr>
<td><img src="image" alt="Reading Speed (Green)" /></td>
<td><strong>Reading Speed (Green)</strong>&lt;br&gt;Tap the left green button to decrease reading speed.&lt;br&gt;Tap the right green button to increase reading speed.</td>
</tr>
<tr>
<td><img src="image" alt="Close (Red)" /></td>
<td><strong>Close (Red)</strong>&lt;br&gt;Tap the red button with the “X” to switch back to video magnifier mode.&lt;br&gt;Press and hold to take a new picture.</td>
</tr>
</tbody>
</table>
**General Operation**

**Magnifying a Document**

After capturing and processing a document, it displays on the screen in Overview mode with navigation bullets marking each reading zone. Overview is the minimum magnification.

To magnify your document, tap the yellow **Plus** button in the button bar.

To decrease magnification, tap the yellow **Minus** button in the button bar.

To quickly switch between Overview and the last used magnification level, tap the **Overview** button.

To magnify a specific area of the document displayed on the screen, press and hold your finger on the text you wish to magnify. Touch the screen as long as you like to zoom in.

To scroll up, down, left or right within the magnified document, simply touch the screen with one finger and swipe up, down, left, or right.

**Reading a Document**

To start reading, tap the white **Play/Pause Speech** button in the middle of the button bar.

To pause reading, tap the button again. The ONYX OCR marks your reading position in the document with a highlight.

To start reading at another position in the document:

- Tap a blue bullet in page overview, or
- Magnify the text and tap a word where you would like to continue reading
This chapter will familiarize you with the ONYX OCR Main menu. Use it to save, open, and delete files; select different languages and voices; choose how text is formatted and displayed on the screen; and configure various speech options.

Opening and Closing the Main Menu

To open the Main menu, tap the grey Menu button in the button bar. It is located in the lower left corner when the button bar appears on the screen.

To close the Main menu, tap the red Close button. It is located in the bottom right corner of the Main menu.

Any changes made in the menu are automatically saved.
Using the Main Menu

The ONYX OCR menu contains two rows of three large buttons:

- Save
- Open
- Delete
- Voice
- View
- Settings

To open a menu item, tap its button. Activating a button will either change a setting, or open a submenu or list. If a button appears dimmed, the option is unavailable.

Save

To save a document, do the following:

1. Open the Main menu and tap the blue Save button.

2. Select a format in which to save the document:

- **Document.** Save the document using the standard file format. This allows you to view it as plain text or as the original document. To change the viewing mode, refer to *Mode* on page 22.
- **e-PUB.** Select to save the document as an e-reader file or DAISY compatible file
- **DOCX.** Select if you would like to edit the document on a computer with Microsoft Word
- **MP3.** Select to save the document as an MP3 audio file
When saving a document as an audio MP3 file, you will need to select the reading voice. The list of voices to choose from are the Nuance® voices of the selected language, or the voices of the languages detected if automatic language detection is enabled.

Not all voices can be used to save as an MP3 audio file. The available voices are limited to only the Nuance voices. In case no Nuance voice is installed, the MP3 button will be greyed out and this option is not available for the selected language.

Only one voice will be used for the entire MP3 file. Automatically switching between languages within an MP3 audio file is not supported.

Saving a document in MP3, DOCX or e-PUB takes longer than the standard format. Especially saving a multipage document in MP3 format could take several minutes.
3. After you selected the format to save the document in, you will be asked if you would like to save your document with a voice label.

Select **No** if you wish to save a document without a voice label. The document will be saved using the first line of the document as the name of the document.

Select **Yes** if you would like to add a voice label. You will hear a beep after which you have five seconds to record a voice label. At the end of the recording you will hear another beep sound. The document will be saved with the recorded voice label.
4. When the document is saved, the ONYX OCR will ask if you would like to append more pages to the document.

If you select No, the menu closes and shows the document again.

If you select Yes, you can start appending more pages to the document by placing the page in the document outline and tapping the screen once to capture the new page.

To stop appending more pages to the document, tap the red Close button.

5. The ONYX OCR will prompt you with the question if the captured pages should be processed. If No is selected, the conversion to text will be done while reading the document. If Yes is selected, all pages will be processed before returning to the document reading mode. This process may take several minutes, depending on the number of pages of the document.

By default a document will be saved on the SD card delivered with the ONYX OCR. If you wish to save your document on a USB drive, connect a USB drive to the ONYX OCR (located on the right side of the monitor). When a USB drive is connected the document will be saved automatically on the drive.
To open a document or view pictures, do the following:

1. In the Main menu tap the green Open button.
   
   - Select the **Document** button to see the list of saved documents. The most recently saved document appears first.
   
   - Select the **Pictures** button to open and view pictures

2. Scroll the list of documents or pictures using the scroll bar on the right side of the screen. If you touch the screen and slowly move your finger over the documents, the title of the document is read aloud. To select a document simply tap it.
3. In the list, tap the document or picture you wish to read or view. The menu closes and the document or picture opens. Pictures can be magnified. It is also possible to open text documents in TXT format or photos from a USB stick. To open documents in TXT format, the document should be located in the root of the USB stick or SD card.
Delete

To delete a document, do the following:

1. In the Main menu tap the red **Delete** button to see the list of documents.

2. Select the document you wish to delete. A confirmation message appears.

3. To delete the document, select **Yes**.
   
   To cancel deleting the document, select **No**. Both choices will return you to the list of documents.
Voice

Tap the white **Voice** button to select a reading voice and language. To select another reading voice, tap the button again to switch to the next configured voice.

If adjusting the reading voice results in a change of language, the menus will automatically change to the same language.

To add or delete voices and languages from the voice selection, refer to **Voice (Settings)** on page 23.

**Note:** When automatic language detection is enabled (refer to **Options** on page 25), this button only changes between voices of the detected language. For instance, if the detected language is English this button will only change between the different English voices. With automatic language detection enabled, you will not be able to change the language of the menu.

To change the menu language, either:

(1) Disable automatic language detection, or

(2) Scan a document in your preferred menu language and change the voice once in the menu, or

(3) Close and restart OCR mode. Open the Main menu followed by Settings. Select Voice settings to choose your menu language.
The **View** menu contains three buttons:

- **Color.** Choose a pre-defined color combination (for example, yellow text on a black background) to reduce glare and provide contrast. This makes it easier to read text on the screen.

- **Mode.** Choose different ways to format text on the screen, for example, column or line format.

- **Highlight.** Choose how you want text to be highlighted on the screen as it is spoken. For example, the highlight can appear around words or lines of text.

### Color

This option is not available when viewing a photo or other document with no text. Tap the yellow **Color** button to cycle through the available high contrast text foreground and background color combinations. The colors that can be selected are:

- Black – White
- Yellow – Blue
- Black – Green
- Blue – White
- White – Black
- Blue – Yellow
- Black – Green
- White – Blue
- Yellow – Black
- Black – Red
- Black – Purple
- Black – Amber
- Red – Black
- Purple – Black
- Amber – Black
Mode

Tap the yellow **Mode** button to select the default viewing mode. The viewing modes that can be selected are Column, Line, Page high contrast and Page full color.

- **Column mode.** Text is reformatted and displayed in a column to fit the width of the screen regardless of the text size. Pictures are not shown in this mode.

- **Line mode.** Text is reformatted and displayed in one continuous line, and the highlighted word is always displayed at the center of the screen. Pictures are not shown in this mode.

- **Page Mode.** Shows a photograph of the document in its original layout, including the pictures. There are two Page modes, the high contrast Page mode and full color Page mode. In the high contrast Page mode the text is displayed in the selected high contrast colors.

Highlight

This option lets you choose a word highlight, line highlight or no highlight. Both the color of the word and line highlight can be changed from red to yellow. The red word highlight is the default.
Tap the gray **Settings** button to enter the Settings menu. It contains four buttons:

- Voice
- Restore Defaults
- Options
- About

**Voice (Settings)**

The **Voice** button in the settings menu opens a list with all available reading voices and languages. Selecting this button will open the languages list.
To add or remove a reading voice, select the language from the list by tapping the language. This will display a list with available voices for the selected language.

To enable a reading voice, select it from the list by tapping it. A checkmark in front of the voice name indicates it is enabled. When the voice is enabled, it will be available under the **Voice** button in the Main menu.

By deselecting a voice, the voice will be removed from the available reading voices. The languages of which a reading voice is selected, will appear at the top of the list with languages, and be marked with a checkmark.
Options

The Options menu contains the following configuration settings:

- Text recognition quality
- Automatic language detection
- Activate Speech
- Column filter
Text Recognition Quality

This option lets you set the recognition quality. The “Optimal” setting is the recommended mode and will offer the best text recognition quality. The “Fast” mode is for simple documents without columns and pictures. The “Fast” mode is up to 30% faster than the “Optimal” mode.
Activate Speech (Starting OCR Mode)

This option lets you configure how to start OCR mode by tapping either in the bottom right corner (default) or anywhere on the screen.
**Automatic Language Detection**

When Automatic Language Detection is enabled, the ONYX OCR will detect the language of the text reading zone or paragraph, and automatically select the correct reading voice. The ONYX OCR is capable of detecting multiple languages in one page.

To enable the language detection, first enable up to maximum five languages. To do this, go to the Voice (Settings) selection menu (page 23), and enable a language by selecting at least one voice per language. Do this for a maximum of five languages. Now make sure the language detection is enabled in the Options menu.

---

**Note:** In case the ONYX OCR is not able to detect the language, the language of the menu is being used. If English is one of the selected languages, the ONYX OCR will use an English voice and will ignore the menu language.
**Column Filter**

This option contains two settings:

- Ignore incomplete columns
- Include incomplete columns

When “Ignore incomplete columns” is enabled, the OCR algorithms will try to detect if text columns are cut off at the left or right margin of the picture. Disabling the filter will include partial columns and will read all detected text on the page. The “Ignore incomplete columns” is the recommended and default setting, offering the most comprehensive text recognition. The “Include incomplete columns” will try to detect all text on the page, but may result in incomprehensive text at the beginning or end of the document.

**Restore Defaults**

If you wish to restore the default settings, select this button. You will be prompted if you are sure to restore the defaults. To restore the defaults select **Yes**. To cancel restoring the defaults, select **No**.

The default settings are:

- **View**. High contrast on
- **Color**. Black on white
- **Highlight**. Word

**About**

The About screen shows the version of the Application interface, camera interface, OCR interface and the mains frequency.
Removing OCR Camera for Travel

You must remove the OCR camera from the touchscreen display if you want to transport the unit in the optional wheeled carrying case.

1. Slide the camera’s mounting bracket from the upper left corner of the touchscreen display as shown below.

![Camera Removal Illustration](image)

**Note:** Use caution when handling the camera so that you do not damage the attached camera cables.

2. Place the camera behind the touchscreen display so that it rests between the back of the screen and the unit’s carrying handle.

3. To reattach the camera, repeat this procedure in reverse order.
You can contact Freedom Scientific Technical Support to receive technical assistance.

To contact by web, visit www.FreedomScientific.com/Forms/TechSupport, and complete the form to submit questions.

To contact by e-mail, send questions to support@vfogroup.com.

To contact by telephone, U.S. customers can call (727) 803-8600, Monday through Friday, from 8:30 AM to 7:00 PM (Eastern Time).

When you call, please provide the following information:

- Product name
- Product serial number
- What you were doing when the problem occurred
- How you tried to solve the problem

Warranty Information and Product Registration

The ONYX OCR and its accessories come with a two-year warranty against manufacturing defects.

Note: These devices have no user-serviceable components. Any unauthorized attempt to service or replace internal components will void the product warranty.

Please call Freedom Scientific Technical Support at (727) 803-8600 for assistance in troubleshooting any problems. If necessary, the technical support specialist will issue a Return Materials Authorization (RMA) number that must be referenced on the outside of the package containing your returned unit. The unit or its accessories will then be exchanged or repaired as needed.

Visit www.FreedomScientific.com/Forms/ProductRegistration to register your product and validate your warranty.